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ABSTRACT 

 

With the extensive use of non-linear devices in the electric power systems, it has become an 
important engineering practice to develop a model for harmonic measurement and analysis in 
order to find the right conditions to design and operate power apparatuses that can reliably 
operate in harmonics environment..A system can still function satisfactorily in the presence of 
limited amount of harmonics. However, the increasing use of non-linear loads in industry is 
keeping harmonic distortion on the rise. The rising harmonic distortion in electric power system 
can result in communication interference, overheating of power apparatus and the malfunction of 
solid-state devices. 

Harmonic measurements in electric power systems are essential to achieve three objectives. 
Firstly, for the identification of the sources and characteristics (magnitude, frequency and 
location) of the harmonics. Secondly, for the design of a filtering system to reduce the harmonic 
impacts to the electric power system. Thirdly, to ensure that total harmonic distortion after 
compensation is in compliance with the regulatory requirements such, as IEEE standards. 

In the present thesis, graphical programming of LabVIEW software has been utilized to develop 
a universal virtual harmonic analyzer to detect the harmonic components of a power wave and 
also to calculate its total harmonic distortion (THD).The power spectrum plots help us to 
visualize the percent of total power being carried by different harmonic levels. Thus, we can 
have the picture of the amount of energy being utilized by power waves. 
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1. INTRODUCTION 

 

1.1 INTRODUCTION 
 
Rapid growth in the industrial and domestic   loads and the usage of various electrical and 
electronic equipment have been witnessed during the recent past .With the surge of the total 
number and capacity of the nonlinear components, the electrical harmonic pollution is becoming 
more and more serious and has been a great threat to the safety of electric power systems and the 
national economy as a whole. 
 
Treatment of harmonics in power systems is thus a major concern of power system 
administrators as well as for engineers. In this task, the measurement of harmonics in power 
networks, as the basic data provider for harmonic analysis and control, is one of the issues of 
fundamental importance. 
 
At this modern industrial world 90% of the Electrical supply is flown through Power a electronic 
converter (nonlinear loads) that produces harmonics, which are disturbing the other equipments 
connected in the same supply. Hence it is necessary to measure the harmonic components to 
estimate their effect. The separation of various frequency components with respect to the 
fundamental frequency is carried out to calculate the Total Harmonic Distortion (THD) which is 
useful to design suitable filters to remove the harmonics in the power signal. 
 
This thesis proposes a novel method to analyze the harmonic contents in a sinusoidal signal. The 
proposed method is carried out using ‘Virtual Instrumentation’ concept with the help of Lab 
VIEW. 
. 
Traditional methods of measuring power system harmonics employ power harmonic analyzers 
through Mat lab. However, these methods usually do not have powerful graphical programming 
capabilities and network functions for remote monitoring and control. This thesis presents a 
novel approach using a virtual instrument (VI) system with data transfer ability to perform power 
system harmonic measurement based on the interpolating windowed Fast Fourier transform 
(FFT).. The virtual instrument system is designed and implemented in LabVIEW environment. 
Harmonic parameters of three-phase voltage and current signals, such as the total harmonic 
distortion (THD) and the distortions of the 1st  to  9th  harmonics can be measured and results  
predicts the accuracy and the performance of the system. 
 
As saving of electrical energy is the main target of industrial consumer and also utility, the use of 
energy efficient equipment increases rapidly. The modern industrial system utilizes variable 
speed drives through thyristor converters as the control becomes simple, more efficient   and 
widely available. However, it gives rise to a varied harmonic spectrum on the ac power systems 
and pollutes the system. In initial period the converter drives were used sparingly for very 
specialized applications due to non availability of the higher rated components and higher cost 
components. However due to modern developments the components are easily available, their 
reliability has improved and cost becomes manageable. Hence the use of these drives grew 
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rapidly and the utilization increased. Due to large usage of these equipments, the electrical power 
slowly and slowly started getting corrupted by introducing harmonics in power systems. Though 
technocrats are generally aware of the harmful effects of the harmonics, the 
elimination/reduction of these harmonic currents and distortion due to this remain reflected topic 
as there is no strict mandatory rule and regulations and the industry does not want an additional 
cost burden which they feel does not give direct cost benefit. 

 
1.2 METHODOLOGY 
 
This thesis deals with analysis and detection of harmonics generated in the electrical power 
system with the help of a virtual harmonic analyzer build through LabVIEW software. LabVIEW 
provide a unique way to analyze any wave with the help of its power package known as 
“DISTORTION ANALYZER”. The virtual harmonic analyzer put together this unique feature of 
LabVIEW. Also, LabVIEW provides for simulating any sort of wave through its graphical 
programming technique. 
 
1.3 OBJECTIVE OF THIS DISSERTATION 
 
Objective of this dissertation can be enumerated as follows 
 

1) To analyze and study distortion in a pure sine wave due to various harmonic levels. 
 

2) To analyze and compute total harmonic distortion of a power wave due to presence of 
harmonics. 
 

3) To compare and analyze the percent of total energy being wasted due to presence of 
harmonics. 
 
 

1.4 DISSECTION OF DISSERTATION 
 

The material of this dissertation has been organized in six chapters. The contents of each chapter 
are briefly outlined as below: 
 

Chapter1-discusses the importance of harmonic analysis and enumerates the objective of 

this thesis. 
           Chapter2-discusses on literature review. 
 
           Chapter3-discusses the features of LabVIEW. 

 
           Chapter4-discussses the THD analyzer build with the help of LabVIEW. 
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           Chapter5-discusses the various waves simulated for THD computation. 
 

           Chapter6-discusses the result. 
 
 
 

1.5 CONCLUSION 
 

This chapter gives brief introduction about importance of harmonic analysis and THD 
calculation of a power wave. It also presents the outline of the project design. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
. 
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2. LITERATURE REVIEW 

2 .1 BACKGROUND OF POWER SYSTEM HARMONICS 

In ideal situation, the electric power in a network is supplied at a constant system frequency, 
known as the fundamental frequency, and at specified voltage magnitudes. In a realistic power 
system, however, the frequency and voltages are deviated from their designated values. The 
deviation of a wave form its perfect sinusoid is generally expressed in terms of harmonics. 
Harmonics in a power system deteriorate the quality of electric energy and can result in 
 

(1) communication interference 
 

(2) overheating of power apparatus 
 

(3) the malfunction of control devices . 
 

There are two general categories of harmonic sources: (a) saturable devices and (b) power 
electronic devices. Saturable devices produce harmonics due mainly to iron saturation, as is the 
case for transformers, rotating machines, and fluorescent lightings (with magnetic ballasts). 
Power electronic loads draw power only during portions of the applied voltage waveform. Thus, 
the current drawn by the load is no longer sinusoidal and appears chopped or flattened. The non-
sinusoidal current can interact with system impedance to give rise to voltage distortion 
and, in some cases, resonance. These power electronics loads include switch-mode power 
supplies, fluorescent lightings (with electronic ballasts), voltage source converters and 
equipments with non-linear components. Today, harmonics induced by non-linear power 
electronic loads present inefficient operations of local and global power supply systems. 
Harmonics have a number of effects on power system components and loads. Power system 
problems such as communication interference, heating, and solid-state device malfunctions can 
be the direct result of harmonics. These problems are categorized and listed below. 
 

a) communication interference; 
 

b) excessive losses and heating in motors, capacitors, and transformers; 
 
          c) degraded meter accuracy; 

 
          d) blown capacitor fuses and failed capacitor; 
 

e) solid-state device malfunctions 
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2.2 WHY HARMONIC ANALYSIS 

 

When a voltage and/or current waveform is distorted, it causes abnormal operating conditions in 
a power system such as- 

 Voltage Harmonics with high peak values can weaken insulation in cables, windings, and 
capacitors. 

 Voltage Harmonics can cause malfunction of different electronic components and circuits 
that utilize the voltage waveform for synchronization or timing. 

 Current Harmonics in motor windings can create Electromagnetic Interference (EMI). 

 Current Harmonics flowing through cables can cause higher heating over and above the 
heating that is created from the fundamental component. 

 Current Harmonics flowing through a transformer can cause higher heating over and 
above the heating that is created by the fundamental component. 

 Current Harmonics flowing through circuit breakers and switch-gear can increase their 
heating losses. 

 RESONANT CURRENTS which are created by current harmonics and the different 
filtering topologies of the power system can cause capacitor failures and/or fuse failures 
in the capacitor or other electrical equipment. 

 False tripping of circuit breakers and protective relays. 
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2.3LITERATURE SURVEY ON HARMONIC MEASUREMENT BASED 
ON LabVIEW 

 

L .L .Lai and W . L. Chan [1] designed a new proposal on real-time frequency and 
harmonic evaluation  using Artificial neural networks and the concept of FFT.A neuron 
model based on FFT technique was developed to evaluate frequency and harmonics. 
 
H.C .Lin [2] proposed an alternative technique to measure line current harmonics with 
high accuracy, efficiency and simplicity through graphical interface. The successful 
operation of remote measurement and monitoring for power system harmonics via the 
internet explorer was also proposed. 
 
Hsiung Cheng Lin [3] proposes an alternative technique to measure line currents using 
human graphical interface as well as remote harmonic analysis and web viewing. The 
proposed system was constructed by the microprocessor Intel (8051) and LabVIEW 
package. 
 
Wang Zhen and Li Yi Hua [4] proposed a new measuring method of harmonics based 
on wavelet neural network. According to knowledge of wavelet transform and self-
learning function of neural network, wavelet neural network is constructed by non-linear 
sigmoid functions. It has stronger capacity of approximation. The measuring method 
proposed has been simulated by programs, simulation results were obtained for 
feasibility and validity. 
 
Robert G. Ellis [5] proposed a technique to analyze harmonics in industrial application 
based on LabVIEW and graphical programming. The paper also developed a virtual 
harmonic analyzer using the packages provided in LabVIEW. 
 
IEEE Working Group on POWER System Harmonics [6] develops a new virtual 
instrument for harmonic measurement and power wave analysis. The virtual instrument 
is designed with the help of LabVIEW software. Also THD calculator is designed using 
the concept of block diagram facility given in LabVIEW. 
 
 
Phang Yoke Yin and M.V . Chilukuri [7] developed a computer based data acquisition 
system that provides real time monitoring of voltage and current. Any power quality 
disturbances sustained by the user throughout the monitoring period were detected and 
recorded on remote PC and was analyzed using LabVIEW programming 
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2.4CONCLUSION 

A brief literature review on harmonic measurement and analysis using LabVIEW 
has been presented in this chapter with some highlights on importance and need of 
harmonics measurement and analysis. 
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3. BRIEF DESCRIPTION OF LabVIEW 

 

3.1INTRODUCTION 

LabVIEW is an integral part of virtual instrumentation as it provides an easy way to use 

application development environment specifically with the need of engineers and scientists. It is 

a graphical programming language for developing diverse applications in a multitude of 

industries. The block diagram provides a unique form of source code to most programming 

languages.Labview extends this innovation to the user providing tremendous freedom of 

expression and creativity. 

 

3.2 VIRTUAL INSTRUMENTATION 

Virtual instrumentation sets a new standard in measurement by replacing bench top instruments. 

It uses software like NI LabVIEW and hardware like PCI modules for data acquisition, 

instrument control and automation. VIs constructed with software are inexpensive, more 

accurate, maintenance free, can sense different physical quantities offering any range, compared 

to physical instruments. VIs works fast, handles repetitive tasks, processes data, stores results, 

generates reports, increases test safety and is controllable by the user. It saves time, money and 

increases productivity; customizability e.g. same code can be re-used for testing similar 

instruments. For any lab instead of buying individual instruments, VI can be employed in a 

computer for all measurements. 

 

Virtual Instruments versus Traditional Instruments 

Traditional instruments: Vendor defined, Function-specific; stand-alone with limited 

connectivity. Hardware is the key, Expensive, Closed, fixed functionality, slow turn on 

technology (5–10 year life Minimal economics of scale). 

Virtual Instruments: User-defined, Application-oriented system with connectivity to networks, 

peripherals, and applications. Software is the key, low cost, reusable, Open, flexible functionality 

leveraging off familiar computer technology (Maximum economics of scale). Software 

minimizes development and maintenance costs. 
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3.2.1 PROGRAMMING TECHNIQUES 

LabVIEW programs are called virtual instruments or VIs, because their appearance and 

operation imitate physical instruments, such as oscilloscopes and millimeters. LabVIEW VIs 

contain three components: the front panel window, the block diagram, and the icon/connector 

pane. 

Front panel Window 

The Front panel window is the user interface for the VI. Fig.3.2 shows example of a front panel 

window. We create the front panel window with controls and indicators, which are the 

interactive input and output terminals of the VI, respectively. 

 
Fig.3.1 VI Front Panel 

 

 

 

 

 

Block Diagram Window 

After creating the Front Panel Window, we add code using graphical representation of functions 

to control the Front panel objects. Fig.3.3 shows an example of a block diagram window contains 

this graphical source code. Front panel objects appear as terminals on the block diagram. 
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Fig. 3.2 VI Block Diagram 

 

Icon and Connector Pane 

A VI can be used as a subVI. A subVI is a VI that is used in another VI, similar to a function in a 

text based programming language. To use VI as a subVI, it must have an icon and connector 

Pane. 

 
Every VI displays an icon, shown above, in the upper right corner of the front panel and block 

diagram windows. An icon is a graphical representation of a VI. It can contain text, images, or a 

combination of both. If we use a VI as a subVI, the icon identifies the subVI on the block 

diagram of the VI. The default icon contains a number that indicates how many new VIs we have 

opened since launching LabVIEW. Create custom icons to replace the default icon by right-

clicking the icon in the upper right corner of the front panel or block diagram and selecting Edit 

Icon from the shortcut menu or by double-clicking the icon in the upper right corner of the front 

panel. We also can edit icons by selecting File»VI Properties, selecting General from the 

Category pull-down menu, and clicking the Edit Icon button. Use the tools on the left side of the 

Icon Editor Dialog box to create the icon design in the editing area. The normal size image of the 

icon appears in the appropriate box to the right of the editing area, as shown in the following 

dialog box in Fig.3.3. 
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Fig. 3.3 Icon Editor 

Use the options on the right side of the editing area to perform the following tasks: 

• Show Terminals—Displays the terminal pattern of the connector pane. 

• OK—Saves the drawing as the icon and returns to the front panel. 

• Cancel—Returns to the front panel without saving any changes. 

The menu bar in the Icon Editor dialog box contains more editing options such as Undo, Redo, 

Cut, Copy, Paste, and Clear. 

To use a VI as a subVI, we need to build a connector pane, shown at left. The connector 

pane is a set of terminals that corresponds to the controls and indicators of that VI, similar to the 

parameter list of a function call in text-based programming languages. The connector pane 

defines the inputs and outputs we can wire to the VI so we can use it as a subVI. Define 

connections by assigning a front panel control or indicator to each of the connector pane 

terminals. To define a connector pane, right-click the icon in the upper right corner of the front 

panel window as shown in the Fig. 3.4 and select Connector from the shortcut menu. The 

connector pane replaces the icon. Each rectangle on the connector pane represents a terminal. 

Use the rectangles to assign inputs and outputs. The number of terminals LabVIEW displays on 

the connector pane depends on the number of controls and indicators on the front panel. The 

following front panel has four controls and one indicator, so LabVIEW displays four input 

terminals and one output terminal on the connector pane. We cannot access the connector pane 

from the icon in the block diagram window. 
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Fig. 3.4 shows icon/connector pane on top right side (orange color box) 

Palettes 

LabVIEW has graphical, floating palettes to help you create and run VIs. The three palettes 

include the Tools, Controls, and Functions palettes. We can place these palettes anywhere on the 

screen. 

Tools Palette 

We can create, modify, and debug VIs using the tools located on the floating Tools palette. The 

Tools palette is available on the front panel and the block diagram. A tool is a special operating 

mode of the mouse cursor. When we select a tool, the cursor icon by itself changes to the tool 

icon. Use the tools to operate and modify front panel and block diagram objects. Next select 

Window»Show Tools Palette to display the Tools palette as shown in Fig.3.5. We can place the 

Tools palette anywhere on the screen. Press the <Shift> key and right-click to display a 

temporary version of the Tools palette at the location of the cursor. 

 
Fig 3.5 Tools palette 

Use the Operating tool to change the values of a control or select the text within a control. 

Use the Positioning tool to select, move, or resize objects 

Use the Wiring tool to wire objects together on the block diagram. 
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Control and Function Palettes 

The Controls and Functions contain sub-palettes of objects to create a VI. When click on sub-

palette icon, the entire palette changes to the selected sub-palette. To use an object on the 

palettes, click the object and place it on the front panel or block diagram. 

Controls Palette 

Use the Controls palette to place controls and indicators on the front panel. The Controls palette 

is available only on the front panel. From there select Window»Show Controls Palette or right-

click on the front panel workspace in order to display the Controls palette as shown in Fig.3.6. 

We also can display the Controls palette by right-clicking an open area on the front panel. Tack 

down the Controls palette by clicking the pushpin on the top left corner of the palette. 

 

 

Fig 3.6 Control Palette 

 

 

Functions Palette 

Use the Functions palette to build the block diagram. The Functions palette is available only on 

the block diagram. Select Window»Show Functions Palette or right-click the block diagram 

workspace to display the Functions palette as shown in Fig.3.7. You also can display the 

Functions palette by right-clicking an open area on the block diagram. Tack down the Functions 

palette by clicking the pushpin on the top left corner of the palette. 
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Fig 3.7 Function palette 

 

3.2.2 Starting a VI 

When we launch LabVIEW, the following dialog box appears as shown in Fig.3.8. 

 

 
Fig 3.8 start window that appears when LabVIEW is launched 
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Fig 3.9 Dialog box for Getting Started of LabVIEW 

The LabVIEW dialog box includes the following components: 

• Click the New VI button to create a new VI. 

• Click the Open VI button to open an existing VI. 

• Click the DAQ Solutions button to launch the DAQ Solution Wizard, which helps we find 

solutions for common DAQ applications. 

• Click the Search Examples button to open a help file that lists and links to all available 

 

LabVIEW example VIs 

• Click the LabVIEW Tutorial button to open the interactive LabVIEW Tutorial. Use this tutorial 

to learn basic LabVIEW concepts. 

 

3.2.3 Troubleshooting and Debugging VIs 

Use the Context Help window and the LabVIEW Help to help you build and edit VIs. 
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Context Help Window 

To display the Context Help window, select Help » Show Context Help or press the <Ctrl-

H>key. When we move the cursor over front panel and block diagram objects, the Context Help 

window displays the icon for sub VIs, functions, constants, controls and indicators, with wires 

attached to each terminal. When we move the cursor over dialog box options, the Context Help 

window displays descriptions of those options. In the window, required connections are bold, 

recommended connections are plain text, and optional connections are dimmed or do not appear. 

The following is an example Context Help window as shown in Fig.3.10. 

 
Fig. 3.10 shows Context Help 

Click the More Help button to display the corresponding topic in the LabVIEW Help, which 

describes the object in detail. 

 

3. 3 Advantages of VI: 

Long before people used typewriters, which were then replaced by the word processors that 

offered new levels of productivity and flexibility. Much as the same way, VIs will replace the 

physical instruments. 

 
 

The picture on the top is that of a real instrument and the one on the bottom is that of a virtual 

one. Today's computer's graphic capabilities even make VIs look like real instruments. Virtual 

instruments are better connected to PC technologies widely used in industries. With VI, users can 

move applications seamlessly between several bus architectures, such as PC Card, plug-in DA 
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hardware, and VXI. This portability offers the flexibility to take advantage of improved bus 

standards as they arise. 

Customizability VIs are fully customizable. Range, accuracy, amount of information provided by 

them can be selected by users. Data can be saved in computer and send it over the internet. They 

can be made to sense any physical quantity offering any range with the use of corresponding 

sensors. A VI can be made to control any other instruments including another VI. 

Increases productivity VIs are less expensive and maintenance free. They work very fast, handle 

repetitive tasks, process data, store results and also generate reports. Reuse of code is also 

possible. Thus the same code can be used for testing similar instruments which saves time and 

money. Doing things in less time would definitely mean being able to do more. With less time, 

money and human labour for the same product, the productivity increases rapidly. 

Lowers cost for customers Physical instruments are not suited for extreme weathers, but VIs can 

work in any hazardous environments. When a new product is tested using expensive test 

equipments, it naturally raises the overhead cost. Employing VI there reduces the testing cost. 

They also increase the test safety. They do not get damaged and thus no need of replacements. 

This lessens the price of the final product for customers. 

User friendliness The software used for VI is user friendly. In LabVIEW, new users can step 

through the dialogue boxes and quickly build a fully functioning DA application. LabVIEW will 

help define signal types, connections, and transducer equations before building the system. Thus, 

the learning curve is shortened significantly. More experienced developers can use the DAQ 

Wizards to prototype a system. 

 
Most VI system contains a microprocessor, a data-acquisition unit or system, an I/O port, a 

display or a way of reporting the results and an analysis engine. Since most of the hardware is 

the same, only the front-end of the device needs to be changed to suit the equipment's purpose. 

With a personal computer, software could do the analysis after acquiring the needed data. Thus, 

the software could be written as such to specifically answer what is called for by the analysis. 
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The hardware could be changed according to the design of the experiment, whether it will 

receive data from an apparatus or control it. Instead of using separate hardware front-ends, 

software could be written for measuring different quantities. Thus with sensors and appropriate 

software, any physical quantity can be acquired and measured in VI. 

Some other applications of VI are data analysis, systems control, process automation, testing and 

calibration of instruments, telecommunications, semiconductor manufacturing, automotive 

testing, robotics, automation, embedded systems, etc. 

3.4 CONCLUSION 

The future of virtual instrumentation is promising. As such companies as Intel and Microsoft 

continue to usher in new technologies for advanced productivity and connectivity; virtual 

instrumentation’s benefits will increase. Improvements in PC technology and VI hardware and 

software will make new applications possible. Companies like National Instruments are 

promoting VI to make it reach everyone. Quite sooner the traditional instrumentation will be 

completely moved inside the computer. 

  



 

21 

 

 

 

 

 

 

 

              CHAPTER 4 
 

 

 

 

 

 
  



 

22 

4.DESIGN OF VIRTUAL HARMONIC ANALYSER 

 

4.1 INTRODUCTION 

The ever growing proliferation of power switching devices for source conditioning and motion 

control in single-phase and three-phase modern industrial applications has increased the 

eventuality of unbalanced currents, unacceptable harmonic levels, and poor power factor in 

three-phase distribution systems. The harmful and costly effects of harmonics have been 

extensively discussed [8] and spurred stringent requirements by international institutions 

regarding the allowed levels of harmonics at the point of connection to the power supply [9]–

[11]. The unbalanced loading of the three-phase supply has no less detrimental effects, such as 

the underutilization of the power supply equipment and the overloading of neutral conductors 

with the fundamental frequency in addition to harmonic currents. Finally, as is well known, a 

phase displacement between the corresponding voltages and currents indicates both a low 

utilization of the generation and distribution equipment and increased line losses for the same 

power consumption level. 

 

4.1.1 Total Current and Voltage Harmonic Distortion 

Harmonic distortion is the corruption of the fundamental sine wave at frequencies that are 

multiples of the fundamental. Power signal waveforms are not clean 50 Hz sine waves. In 

practice the actual waveforms are distorted one due to presence of harmonics. Harmonics occur 

at an integral multiple of the base frequency. In 3-phase system odd harmonics excluding tripled 

frequency are prevalent. Hence 5th, 7th, 9th and even higher order harmonics can be found in the 

supply waveform. Waveform harmonics are usually caused by equipment which draws non-

linear currents. Modern electrical equipment such as computerized equipment and 

telecommunication equipment often use switching power supplies to “step up” or “step down” 

the voltage. This introduces a non-sinusoidal load which pulls current in short pulses during 

every cycle. Other non-linear devices such as digital/electronic components and arching devices 

like fluorescent lamps can cause abnormal waveforms and serious decreases in power quality. 

Other loads contributing to this problem are variable speed motor drives, lighting ballasts and 

large legacy UPS systems. Symptoms of harmonic problems include overheated transformers, 
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neutral conductors, and other electrical distribution equipment, as well as the tripping of circuit 

breakers and loss of synchronization on timing circuits that are dependent upon a clean sine wave 

trigger at the zero crossover point. Harmonic distortion has been a significant problem with IT 

equipment in the past, due to the nature of switch-mode power supplies (SMPS). Methods used 

to mitigate this problem have included over-sizing the neutral conductors, installing K-rated 

transformers, and harmonic filters [9, 10].Harmonics work together in distorting the fundamental 

waveform. Fig.4.1 shows a sinusoidal signal with harmonic content. 

 
Fig. 4.1: Sinusoidal signal with Harmonic content 

The representation of the harmonic current with respect to the fundamental waveform is called 

total harmonic distortion (THD). There is a THD for both voltage and current. The total 

harmonic distortion of the voltage and current VTHD and ITHD, respectively, for single-phase 

(or polyphase balanced) networks have been conventionally defined in the literature as where V 

And I denotes rms values and 1 and h denote the fundamental and the harmonic order, 

respectively. 

 

To account for the fact that higher-order harmonic currents cause greater losses than lower-order 

harmonics of the same amplitude, harmonic-adjusted total voltage and current harmonic 

distortions are, respectively defined as: 

 
Where, Ch and Dh are appropriate weighting factors, greater than one, that monotonically 

increase with the harmonic order h. Various mathematical expressions, by no means exhaustive, 
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for these weighting factors as a function of the harmonic order h .An extension of the above 

concepts to unbalanced polyphase networks . To this end a single “equivalent” harmonic rms 

voltage VeH and harmonic rms current Ieh for the three-phase system a, b, c are defined as: 

 

It is proposed to generalize equations (4.5) and (4.6) and separately weigh individual harmonics 

similar to (4.3) and (4.4), which yield the adjusted harmonic equivalent values 

 

The first introduced quality aspects QA1 and QA2 are identified with the total harmonic 

distortions VTHD and ITHD for a three-phase unbalanced system and are defined as:

 
Where Ve1 and Ie1 denote the fundamental equivalent phase voltage and current defined, 

similarly to Equation (4.5) & (4.6), from the fundamental components of the generally 

unbalanced three-phase voltages and currents as: 

 

Definition of Equations 4.(5-8),4.11 and 4.12  satisfy the particular requirement that the total 

losses in the equivalent balanced three-phase system be equal to those in the actual system 

considered. The underlying assumptions are that a) the line and equipment losses for a certain 

frequency are proportional to either the square of the voltage or the square of the current and b) 

the line and equipment parameters are symmetrical. 
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Linear loads have very low values of THD because they have little or no harmonic current. Non-

linear loads have large values of THD, and cause considerable distortion to the normal sine 

wave. Within the IEEE [9], the standard established limits on harmonic currents and voltages at 

the point of common coupling (PCC) or at the point of metering are 5% THD at the distribution 

system voltage level. As far as the historical development of the compatibility levels within the 

IEC [10] standards framework is concerned, the newly published standard allows THD of the 

voltage to be 11 % for a short period of time, and sets the long-term limit to 8 %. This 

development shows that the trend is to allow for more distortion in the distribution networks in 

the future. 

4.1.2Implementation of QA1 and QA2 in LabVIEW: 

To implement the above quality aspects i.e. QA1 (VTHD) and QA2 (ITHD) using LabVIEW 

first we need to simulate voltage and current waveforms hence voltage and current waveforms 

are simulated keeping in mind the actual distorted waveform due to presence of harmonics which 

occur at integral multiple of the base frequency. In this project distorted waveform has been 

simulated by superimposing 5th harmonic on fundamental frequency waveform. 

To simulate a signal in LabVIEW, first we need to create new VI (File >> New VI) and then it 

will show Front Panel from where we should go to block diagram by pressing <ctr-E> or from 

toolbar (windows>>show Block diagram) from where we should right click anywhere on the 

block diagram then it will show functions palette i.e. (functions>>Express>>Input>>Simulate 

Signal) then you will get simulate signal Express VI which is shown below from where we need 

to configure signal according to our requirement. 

 

Here in this case a balanced three phase non-sinusoidal voltage source was implemented defined 

by Vphase=220V (rms) and by adding a fifth-order harmonic having an amplitude of 5 % of the 

fundamental which is as shown below block diagram. 
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Fig 4.2 Block Diagram /G programming of distorted voltage wave form 

 

Fig 4.3 Front Panel Presenting Distorted voltage waveform 

Here in the Front Panel signal we can see simulation of three phase voltage forms. In the same 

manner distorted current wave form is simulated by assuming a balanced resistive load defined 

by Ra=Rb=Rc =10Ω is connected to above source. 
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Fig 4.4 Block diagram of current wave form 

 

 
 

Fig 4.5 Front Panel presenting current waveform 

 

The above VIs are used as subVI as shown below for calculating QA1 and QA2. A subVI is a VI 

that is used in another VI similar to a function in text programming language . Advantage of 
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using a VI as subVI is to simplify the programming complexity. The programmer can easily 

manage and test these subtasks to reduce dependencies tha might cause unexpected behaviour 

this shows the importance of modularity property in LabVIEW. 

 
QA1 and QA2 are calculated by programming the above discussed formulas in block diagram 

which is as shown below. 

 
 

Fig 4.6 Block diagram of voltage total harmonic distortion analyzer 
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Fig 4.7 Front Panel Presenting Voltage Total Harmonic Distortion Analyzer 

Similarly, 

 
 

Fig 4.8 Block diagram of current total harmonic distortion analyzer 
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Fig 4.9 Front Panel Presenting Current Total Harmonic Distortion Analyzer 

 

4..2 The THD Analyzer 

The key programming package includes  “Harmonic Distortion Analyzer” that takes a signal in 
and performs a full harmonic analysis, containing measuring the fundamental frequency tone and 
harmonics  and returning the fundamental frequency  , all harmonic levels, and the total 

harmonic distortion(THD). 
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Fig 4.10 Block Diagram of THD Analyzer. 
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CHAPTER 5 
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5.SIMULATION OF  SEVERAL TEST WAVEFORMS 

 
5.1 Sine wave with 3rd harmonic 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 3rd harmonic with 
amplitude 5% of the fundamental. 

 

 

5.2 Sine wave with 5th harmonic 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 5th  harmonic with 
amplitude 5% of the fundamental. 
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5.3 Sine wave with 7th harmonic 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 7th   harmonic with 
amplitude 5% of the fundamental. 
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5.4 Sine wave with 9th harmonic 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 9th  harmonic with 
amplitude 5% of the fundamental. 

 

 

5.5 Sine wave with 3rd and 5th harmonic 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 3rd and 5th  harmonic 
with amplitude 10% of the fundamental. 
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5.6 Sine wave with 5th and 7th harmonic 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 5th  and 7th  harmonic 
with amplitude 10% of the fundamental. 

 

 



 

37 

5.7 Sine wave with 7th and 9th harmonic 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 7th  and 9th  harmonic 
with amplitude 10% of the fundamental. 

 

 

5.8 Sine wave with 3rd harmonic and uniform noise 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 3rd   harmonic with 
amplitude 5% of the fundamental and uniform noise is added to it. 
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5.9 Sine wave with 3rd and 5th harmonic and uniform noise 

This wave signal is simulated with the help of LabVIEW taking fundamental component of 
amplitude 350 volt and frequency 50hz. It has been superimposed with its 3rd and 5th  harmonic 
with amplitude 10% of the fundamental and uniform noise is added to it. 

 

\ 
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CHAPTER 6 
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6. THD CALCULATIONS AND SIMULATED RESULTS 

 

6.1  Sine wave with 3rd harmonic 
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6.2  Sine wave with 5th harmonic 

 

 

 

6.3  Sine wave with 7th harmonic 
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6.4  Sine wave with 9th harmonic 

 

 

 

6.5  Sine wave with 3rd and 5th harmonic 
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6.6  Sine wave with 5th and 7th harmonic 

 

 

 

6.7  Sine wave with 7th and 9th harmonic 
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6.8  Sine wave with 3rd harmonic and uniform noise 

 

 

 

6.9  Sine wave with 3rd and 5th harmonic and uniform noise 
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CHAPTER 7 
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7. CONCLUSION AND FUTURE SCOPE OF THE WORK 

 
The project describes the utility of virtual instrumentation to offer a cost effective and at the 
same time producing an accurate and speedy analysis report on the signal harmonics. 
 
The objective of this thesis was to introduce the background needed for electrical engineer 
students in understanding of power system harmonics using graphical programming tool. In 
brief, harmonics are energy levels existing at multiples of the fundamental wave’s frequency. 
Harmonics produce undesirable effects in the generator, but motors also suffer from excessive 
harmonics. The remainder of this discussion will be limited to harmonics of lower orders, those with 
significant magnitudes, are the 3rd, 5th, and 7th. Thus, we see that higher the order of harmonics, 
higher is the quantity of energy possessed by it. The same is also depicted in the plots of power 
spectrum in the chapter 6 of this thesis .thus, in the order severity , we can say that a waveform 
containing 7th harmonic is more severe than a waveform containing 3rd harmonic , as more 
quantity of useful energy is wasted. The power spectrum is a powerful analogy tool to show and 
compare the amount of useful energy being wasted due to the presence of harmonics in the signal 
waveform. The observation made so far is, that with the increase in number or order of 
harmonics in a single voltage or current waveform, the amount of useful energy being wasted 
also increases. Thus, harmonics need to be reduced and the voltage or current waveform in a 
power system needs to be as sinusoidal as possible. 
 
The THD Analyzer is a interpolated windowed Fast Fourier Transform (FFT) technique that 
analyses any waveform by giving the harmonic components, THD value and its power spectrum. 
Sine waves with different harmonics components are, first, simulated through a block diagram 
designed with the help of LabVIEW as shown in chapter5. Then these simulated waveforms 
were run through the THD analyzer to obtain the THD value of the various waveforms..These 
results are shown in chapter 6. 
 
This thesis also preserves and presents much wider scope of research and analogy in future times 
by exploring a new potential way of simulating different sort of waveforms with the help of 
LabVIEW(virtual instrumentation) and analyzing the effects of harmonic levels using power 

spectrum plots. 
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